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1 Introduction to Nasdaq Web Trader 
 

Nasdaq Web Trader provides an order management and market information interface to Traders, Firm 

Managers and Firm Viewers. It is deployed as a web server application and users access the application 

through a web browser. 
 

Nasdaq Web Trader consists of a number of different views which allow: 
 

• Order management 
 

• Market information viewing. 
 

The Nasdaq Web Trader features allow the user to: 
 

• Easily see which fields are mandatory to fill in in any given view. Such fields are indicated by an 

asterisk (*). 

• View confirmations and verify transactions before submission 
 

• Customize views by: 
 

• Filtering data on all columns in any given view 
 

• Saving personal settings per view, workspace, and user. 
 
 

1.1 Logging on Nasdaq Web Trader 
 

Using a supported web browser, go to the web address https://trading.opcom.ro/ and enter your 

username and password. 
 

Nasdaq Web Trader requires a web browser that supports HTML5 and Web Sockets. The following 

browsers are supported: 

• Internet Explorer 11 (earlier versions do not support Web Sockets) 
 

• Chrome (only the latest version with auto-update version feature enabled). 
 

Figure 1 - Log In view 
 

 
 

If you want your previous workspace settings to be restored when you log in, check the Restore 

Workspace checkbox. If this checkbox is not checked, the previous workspace will be replaced with the 

Views menu. For more information, refer to section 2.2 Menu button and Views menu. 
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Figure 2 - Nasdaq Web Trader workspace example 
 

 
 
 

1.2 Logging Out 
 

To log out and close Nasdaq Web Trader, click on the Logout button . Confirm the log out by clicking 

the Ok button that appears at the bottom right corner of the screen. Click on Cancel to not log off. 
 

When a user logs off, the workspace is automatically saved, and any changes will be reloaded when you 

log in again if the Restore Workspace checkbox is checked on the Log In view. 
 

 Note: Closing the web browser window will log you out without confirmation. 
 

 

1.3 Changing Your Password 
 

Password strength is calculated on the weights of the password characters. Password strength is passed 

if its total score equals or exceeds a pre-determined threshold. In Nasdaq ME, the threshold is a 

database parameter and the default value is 60%. For the password strength algorithm, please refer to 

http://www.passwordmeter.com 
 

To change your password: 

1. Open the Settings view by clicking the Settings button  on the main menu and click the Change 

Password tab. 
 

Figure 3 - Change Password Tab 
 

 
 
 

http://www.passwordmeter.com/
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2. Type in the new password in the New Password and Confirm New Password fields. 

3. Click Change. The new password will become active immediately. 
 

 
 

2 Nasdaq Web Trader Workspaces 
 

This section shows how to work with workspaces, such as using the main menu buttons, adding views, 

saving and publishing workspaces. 
 

 Note: Any alterations you make to a workspace are immediately saved and cannot be undone. 
 

 

2.1 Nasdaq Web Trader Main menu 
 

At the top right-hand side of the Nasdaq Web Trader is the Main menu. It has three buttons: 
 

• Menu button which opens the Views menu 

• Settings button  which opens the Settings view 
 

• Logout button  to logoff. 
 

Figure 4 – Nasdaq Web Trader Main menu 
 

 
 

The time displayed to the left of the Main menu is the time on the Trading Engine. 
 

The Workspace option to the left of the Main menu allows you to quickly change between saved 

workspaces by selecting a workspace from the Workspace dropdown list. 
 

 

2.2 Menu button and Views menu 
 

The Views menu can be opened from the Menu button  from the Main menu. This displays all the 

views that can be selected to be displayed in a workspace. For more information about the individual 

views, refer to section 4 Views available in Nasdaq Web Trader. To add multiple views to a workspace, 

refer to section 2.7 Creating a Workspace with Views. 
 

Figure 5 – Views menu options 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click on a view, for example, Securities, to open this view in the workspace. 
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Figure 6 - Securities view 
 

 
 

Views can be added to the workspace by clicking and dragging an outside border of the workspace 

window to show the Views menu options and choose a new view. 
 

Figure 7 - Views menu options used to add a view 
 

 
 

 

2.3 Settings view 
 

The user’s Settings view is opened by clicking the Settings button  from the Main menu. 

The Settings view contains four tabs: 

• Workspaces – refer to section 2.4 Workspaces tab 
 

• Colors – refer to section 2.5 Colors tab 
 

• Confirmations – refer to section 2.6 Confirmations tab 
 

• Change Password – refer to section 1.3 Changing Your Password. 
 

 

2.4 Workspaces tab 
 

Use this tab to save, delete, open and publish saved workspaces. When you modify a workspace, it is 

saved between sessions as a temporary workspace and will open when you log in again, provided that 

the Restore workspace check box is selected. If you wish to name it and create a permanent snapshot 

of the workspace that can be opened later or published to other users, save the current workspace 

using the Workspaces tab in the Settings view. 
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2.4.1 Saving Workspaces 
 

Open the Settings view by clicking the Settings button , and then click the Workspaces tab. 
 

Figure 8 - Settings View Workspaces Tab 

 
 

 
 

Under this tab, enter a name of your choice in the Set current workspace as field and click Save. 

Confirm the save by clicking on the  button. 

 

2.4.2 Opening saved workspaces 
 

To alternate between workspaces to view, saved workspaces can be reopened by clicking the Settings 

button  and clicking the Workspaces tab. Select a saved workspace and click the Open button. 

Confirm the open by clicking on the  button. 
 

 Note: The original default workspace can be opened from the Workspaces tab, if required, or by 

selecting ‘Default’ from the Workspace dropdown list on the Main menu. 

 

2.4.3 Publishing saved workspaces 
 

A saved workspace can be published to make it available to other users within the same firm. To publish 

a save workspace, click the Settings button  and click the Workspaces tab. Select a saved workspace 

and click the Publish button. Confirm the publication by clicking on the  button. 

 

2.4.4 Deleting saved workspaces 
 

To delete a saved workspace, click the Settings button  and click the Workspaces tab. Select a saved 

workspace and click the Delete button. Confirm the deletion by clicking on the  button. 
 

 

2.5 Colors tab 
 

The Colors tab displays the color themes available, e.g. Dark for a dark workspace background or Light 

for a white workspace background. 
 

1. Open the Settings view by clicking the Settings button  and click the Colors tab. 

2. Click on the Theme name to change the colors. 
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Figure 9 - Colors Tab example 
 

 
 

Selecting Dark will change the workspace to the color scheme shown below. 
 

Figure 10 - Colors Tab – Dark Color Theme example 
 

 
 
 

2.6 Confirmations tab 
 

The Confirmations tab allows confirmations to be turned on or off for selected actions, such as 

withdrawing orders or deleting workspaces. If the checkbox is selected, a confirmation will be needed 

before the action takes place, e.g. by clicking Ok to proceed with the action or Cancel to cancel the 

action. 
 

Figure 11 - Confirmations tab 
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2.7 Creating a Workspace with Views 
 

Nasdaq Web Trader consists of a number of menu categories, which contain one or several menu items. 

Each menu item opens an individual view. Some views also have subviews, which are views that provide 

a detailed presentation of the contents of one row. Alternatively, these subviews allow you to take 

action. 
 

 Note: The changes you make to the workspace will be immediately saved and cannot be undone. 
 

To customize a workspace: 

1. Open a view of your choice from one of the View menu categories. Use the Menu button  to see 

the views available. 
 

 Note: Views can be added to the workspace by clicking and dragging an outside border of the 

workspace window to show the Views menu options and choose a new view. 
 

2. Move the cursor to the very edge of the window (the gray frame becomes twice as thick when you 

are at the spot where it becomes possible to alter it in size) and resize the window by dragging the 

frames of the window. 

3. In the free area that appears, open another view and resize this window as needed. 

4. Repeat step 3 until you have built a workspace to your liking. 

Your settings will be saved and when you log on with the same user next time, the application will 

open to this workspace, provided that the Restore workspace check box is selected, which is the 

default setting. 

5. If you remove a view from your workspace, the view closest to it will resize in order to fill in the void. 
 

 Note: You are also able to resize the entire workspace. 
 
 

If you want to make sure your changes to a view or workspace are not overwritten, save the workspace. 

Refer to section 2.4.1 Saving Workspaces. This will be a snapshot of the workspace at the time you save 

it and it can be reopened or published. 
 

 

3 Working with Nasdaq Web Trader Views 
 

Views in Nasdaq Web Trader can be table (or grid) views, detail views (available if there is a Details 

button on the view) or dialog boxes, such as Order Entry. 
 
 

3.1 Handling Columns 
 

Views have a default setting for the way in which the columns in that view appear, but you also have the 

option to customize the order in which the columns appear. 

 

3.1.1 Change the sorting order 
 

To change the sorting order of the columns from ascending to descending order and vice versa, click on 

the column header. A small arrow will appear to the right of the column title, signaling the current 

sorting order of that column. 
 

To sort on any column, click on the column header. To toggle between ascending and descending 

sorting order, click several times consecutively on a column header. 
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You can sort on two columns concurrently, that is, first on column A and then on column B. To do this, 

first click on the header for column A, then press the Shift key and click on the header for column B. To 

undo the double sorting, click any column. 
 

Figure 12 - Column sorting 
 

 
3.1.2 Adding columns to a view 

 

To add columns that are hidden by default, click the Column Settings button  in the view and select 

any columns of your choice in the list that appears. Views with tabs, such as Market View and My Orders 

view, do not have this button. 
 

Figure 13 - Column Settings example 
 

 
 

3.1.3 Removing columns from a view 
 

To remove columns that are enabled by default, click the Column Settings button  in the view and 

clear any columns of your choice in the list that appears. 

 

3.1.4 Moving columns in a view 
 

Re-arrange the order of columns in views without tabs by clicking on a column and dragging it to a new 

position in a view. 
 

 

3.2 Using Filters 
 

Filters can be applied in some views in Nasdaq Web Trader. 

 
3.2.1 Generic Filters 

 

The generic filter appears in the title bar of a view. This filter allows you to filter on any column in the 

view (including filtering on hidden columns). 
 

Figure 14 - Generic Filter example 
 

 
 

You can type in a value or wildcard (* or ?) to search for values. Values can be case insensitive text, 

number, date or time. 
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When you start to type into the generic filter control, a list with matching items from which you can 

select an item on which to filter will appear. 
 

Figure 15 - Generic Filter matching items 
 

 
 

As soon as you have selected an item in the generic filter field, a field will be created to the left of this 

field that will be populated with the selected filter item. 
 

Figure 16 - Generic Filter created 
 

 
 

To remove any part of user-defined, generic, filter criteria, click the Exit button (X) next to the filter field. 
 
 

3.3 Mandatory Input Fields 
 

In views that contain input fields and drop-down list boxes, all fields that must be filled out in order for 

you to be able to carry out the action performed in the view are indicated with an asterisk (*) to the 

right of the field in question. 
 

 

3.4 Export Data to CSV button 
 

 

The Export Data to CSV button appears on the upper right-hand side of a view. 

Click this button to export data from the contents displayed in the view to a .csv file. 

 

3.5 Menu button in a view 
 

The Menu button  appears on the upper right-hand side of a view. 
 

 

Click this button to close the current view and instead display all available views. 
 

 Note: Using the Menu button from an open view will close that view and open any selected 

view instead. The Menu button from main menu will open the View menu only. 
 
 

3.6 Using Controls 
 

In Nasdaq Web Trader, use different controls to add, delete, and modify data.  
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The following control types are available: 

• Autocomplete 
 

• Check Boxes 
 

• A pop-up Calendar is available to select dates 
 

• Spin buttons 
 

• Text boxes – If you have entered an invalid value in a field, the background color of this field will 

change to red to signal an incorrect value. Once you enter a valid value, the red background will 

disappear. 
 

 
 

4 Views available in Nasdaq Web Trader 
 

The following view categories are available from the Menu  button: 
 

• Market Data 
 

• Order Management. 
 

Each of these categories contains related views. 
 
 

4.1 Market Data Views 
 

4.1.1 Market View 
 

The Market View contains a list of securities giving a summary of market information for the securities, 

for example: 

• Best current buy/sell price 
 

• High/low/last prices. 
 

The Market View has All, Active, Favorites and Favorites 2 tabs which differentiates it from the 

Securities view. Market View will not save Filter values like the Securities view. 
 

Figure 17 - Market View example 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the All tab to see all the securities. Click on the Active tab to show all active securities.  

The following columns are available in the Market View and Securities view. 

SECURITY The security symbol (also called the sec code), which is an unique code 

used to identify the security 
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BOARD The Board the security is traded on 
 

SESSION The name of the trading session the security is in. The trading session can 

be, for example, Pre-Trade or Continous. Trading session affects what 

activities are allowable on the security. 

STATE The current trading status for the security on a Board. The trading state 

may be either: 

‘Active’. When a security on a Board is active, the security is available to 

be traded on that Board, or 

‘Suspended’. If the security on a Board is suspended, that security on that 

Board will be unavailable for trading. 
 

PRODUCT Unique identifying code for the Product (Instrument) that the security is 

associated with 
 

REF PRICE The reference price of the security. It is the previous settlement price of 

the security by default. 
 

BID QTY Bid quantity at the best price in the order book 
 

BID Current best bid price of an order or trade in the currency of the 

security Board 
 

OFFER Current best offer price of an order or trade in the currency of the 

security Board 
 

OFFER QTY Offer quantity at the best price in the order book 
 

LAST PRICE The Last Traded Price for this security 
 

OPEN The price for the security when the market opened today 
 

HIGH The highest price at which the security was traded today 
 

LOW The lowest price at which the security was traded today 
 

TRADES The number of trades that occurred for the security 
 

VOLUME The total volume traded on the day 
 

TOP Theoretical Order Price. Indicative price when set. 
 

TOV Theoretical Order Volume. Indicative volume of trades. 
 

LISTING DATE The listing date and time of the security 
 

DELISTING DATE The delisting date and time of the security. 
 

Commonly used securities can be easily added to the FAVORITES and FAVORITES2 tabs. Select a security 

and click on either the Favorites or Favorites 2 button. 
 

 
Figure 18 - Market View – FAVORITES 2 tab example 

 

 
 

Click on Remove to remove a security from the FAVORITES tab. Select a security and click Up or Down 

to move the row up or down. Select a security and click on Details to see the Security Details view. 
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Figure 19 - Security Details view example 

                   
 
 

 

4.1.2 Securities view 
 

The Securities view contains a list of securities giving a summary of market information for the 

securities, for example: 

• Best current buy/sell price 
 

• High/low/last prices. 
 

The Securities view has the same columns as the Market View but has no tabs. Refer to 4.1.1 Market 

View for more information. 
 

The Securities view can be filtered using Generic filters. Refer to 3.2.1 Generic Filters for more 

information. 
 

Figure 20 - Securities view example 
 

 
 

Commonly used securities can be added to the FAVORITES and FAVORITES2 tabs in the Market View. 

Select a security in the Securities view and click on either the Favorites or Favorites 2 button. 
 

Select a security and click on Details to see the Security Details view. 

 
4.1.3 Order Depth 

 

The Order Depth view refers to the security selected from the Market View or Securities view. To see 

details of a different Orderbook, click on the security desired from any of these views. 
 

The Order Depth view allows you to view the bids (buy orders) and offers (sell orders) for a selected 

security, sorted by price/time. The buys are displayed in the left side of the view and the sells are shown 

in the right side for the selected security. 
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A Trader’s own orders are highlighted. 
 

Select an order and click on Details to see the Order Details view. 
 

Figure 21 – Order Depth view example 
 
 
 
 
 
 
 
 
 
 
 

The following columns are available in the Order Depth view: 

ID# Unique order number of the bid order assigned by the system 
 

* An asterisk (*) in this column indicates that the Bid (buy) order is a WON (Whole 

or None) order 
 

FIRM The Firm of the trader who placed the bid order 
 

QTY The quantity of the order on the bid side 
 

BID The bid (buy) price of the order 
 

OFFER The offer (sell) price of the order 
 

QTY The quantity of the order on the offer side 
 

FIRM The Firm of the trader who placed the offer order 
 

* An asterisk (*) in this column indicates that the Offer (sell) order is a WON (Whole 

or None) order. 
 

ID# Unique order number of the offer order assigned by the system 
 

 

4.1.4 Price Depth 
 

The Price Depth view refers to the security selected from the Market View or Securities view. To see 

details of a different Orderbook, click on the security desired from any of these views. 
 

The Price Depth view allows you to view the aggregate of bids (buy orders) and offers (sell orders) for a 

selected security, grouped and ordered by price. The buys are displayed in the left side of the view and 

the sells are shown in the right side for the selected security. 
 

Figure 22 - Price Depth view example 
 
 
 
 
 
 
 

 
The following columns are available in the Price Depth view: 

QTY Total visible quantity of all bid orders at this price 
 

BID The bid (buy) price 
 

OFFER The offer (sell) price 
 

QTY Total visible quantity of all offer orders at this price. 



 
 

Nasdaq Web Trader User 
Guide  

 

  

pg. 16 
 

 

 

4.1.5 Market Trades 
 

The Market Trades view lists all the trades performed in the Trading System for the day. Certain trade 

attribute information that is not available to the public, such as Buy Trader ID, Sell Trader ID, Trading 

Account numbers, Buy and Sell Order numbers etc., is not displayed in this table. 
 

Figure 23 - Market Trades view example 

 

  
 
 

The following columns are available in the Market Trades view: 

TIME The time when the trade occurred 
 

SECURITY The security code of the security that was traded 
 

BOARD The Board on which the trade occurred 
 

PRICE The price that the trade traded at 
 

QUANTITY The quantity that the trade traded 
 

VALUE The total value of the trade 
 

STATUS The status of the trade, e.g. Matched. 
 

 

4.1.6 Trading Schedule 
  

The Trading Schedule view shows a list of trade events that have triggered and are scheduled. 
 

Figure 24 - Trading Schedule view  
 

 
 

 
 

The following columns are available in the Trading Schedule view: 

TIME The time that the trading event is scheduled to commence. If no time is 

specified, then the event will begin as soon as it is set. 
 

STATUS The current status of the trading event: 

‘Triggered’ - Indicates the trading event has occurred 
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‘Pending’ - Indicates the trading event has not yet occurred. 

TRANSITION The identifier that the trading system has given to this trading event, e.g. 

Pre-Trade. A Trade Event can be on system wide level, Board level, or at the level 

of a specific Product or Security, so a transition will relate to the entity that the 

event is scheduled for. 
 

BOARD The unique identifier of the Board on which this trading event is scheduled to 

occur 
 

PRODUCT The unique identifier of the Product (Instrument) on which this trade event is 

scheduled to occur 
 

SECURITY The unique identifier of the Security on which this trade event is scheduled to 

occur. 

 
 

4.1.7 News 
 

The News view shows a list of News items disseminated by the Exchange. 
 

Figure 25 - News view example   

 

 

 
 
 

The following columns are available in the News view: 

TIME The time the news was sent out 
 

TITLE A descriptive title for the News item 
 

SECURITY The security code of the security that is the subject of this News item 
 

ISSUER The Issuer responsible for this security 
 

REFERENCE A news reference number. 
 

Click Details to see the whole selected news item in the News Details view. 
 

 

Figure 26 - News Details view example 
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4.2 Order Management Views 

 
 

4.2.1 Order Entry 
 

Buy or sell orders can be entered using the Order Entry view. Click the More down arrow to expand the 

view or the More up arrow to truncate the view. The fields available will change according to the type of 

security selected, e.g. some securities will have Trigger options, and the current trading session. 
 

Figure 27 - Order Entry view example – expanded 
 

 
 
 
 

The following fields are available in the Order Entry view: 
 

Security The short name for the security for this order 
 

Board The Board on which the order is to be placed 
 

Account The Trading Account that the order is being entered for 
 

Quantity The unit quantity of this order 
 

Price The limit price for this order 
 

Type The type of order, i.e. the option selected here will determine whether the price 

for the order is the best market price (Market) or a price limit (Limit) that is set in 

the Price field. 
 

Reference Free form field for reference text 
 

More 
 

Fill Type The type of fill for the order, for example: 
 

None – No contingencies, just normal limit order 
 

WON – Whole or None. A WON order is an order that trades the entire quantity 

in a single trade or remains in the order book. 

FOK – Fill Or Kill. The order must execute as a complete order as soon as it 
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becomes available on the market, otherwise the order is cancelled. 
 

FAK – Fill And Kill. Fill any amount of the order that can be filled against any 

orders in the opposite side of the order book and any remaining quantity of the 

order is immediately withdrawn. The order has an immediate duration only. 
 

Duration Specifies the duration of this order, i.e. its lifetime in the system: 

‘Day’ – The order is withdrawn at the end of the day 

‘Good Till Cancel’ - The order is good until it is cancelled (this is the current 

default value set) 
 

‘Good Till Date’ – The order is good until the date specified in the Expiry Date 

field 
 

‘Good Till Time’ – The order is good until the time specified in the Expiry Time 

field 

‘Immediate’ – The order will be withdrawn if it does not immediately match 

‘Session’ - The order will be withdrawn if it is not matched in the session in 

which it is entered 
 

Expiry Date In the case of a ‘Good Till Date’ order, specifies the date at which the order will 

expire 
 

Expiry Time In the case of a ‘Good Till Time’ order, specifies the time at which the order will 

expire 
 

Trigger If this checkbox is ticked, enter at trigger (stop) price, i.e. the price at which this 

order will be activated and placed into the market. The activation of a Buy Stop 

order will be triggered when a new bid or a trade is at or higher than this price. A 

Sell Stop order will be activated when a new offer or a trade is at or below this 

price. 
 

Trigger Price This is the price that triggers the order activation for Stop orders 
 

Trigger Direction Specifies the direction of price movement for the trigger order to be activated 

(Up or Down) 
 

Trigger Price Type Specifies the type of price movement for the trigger order to be activated, e.g. 

‘B’ (Bid), ‘O’ (Offer) or ‘ L’ (Last traded price). 
 

Once all the order details have been entered, click Bid (buy) or Offer (sell) to enter the order. 
 

Confirm the submitting of the order by clicking Confirm Bid or Confirm Offer. Cancel the order entry by 

clicking Cancel. 
 

 
Figure 28 - Confirm Submit order 

 

 
 

If the order is accepted, the following message will be displayed. 
 

Figure 29 - Order Entry success message 
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If the order is rejected, an error message will be displayed. 
 

Figure 30 - Order Entry error message 
 

 
 

 
4.2.2 Order Import 

 

Orders can be imported from a CSV file using the Order Import view. 
 

Figure 31 - Order Import view example 
 
 
 
 
 
  

 
The CSV file needs to contain the correct column headings. The column heading names map to those 

used in the Order Entry view as shown in the example below. 
 

Figure 32 - Order Import - Example CSV file 

 

 
 

Click on the Import button. A Windows Open dialog box will open and the CSV file containing the orders 

data can be selected for import. 
 

Figure 33 - Order Import view - imported orders example 
 
 
 
 
 
 
 
 
 
 
 
 

 
If there are errors, the cells containing the erroneous, or missing, data will be colored red. 

To remove all the orders, click Clear. 

To submit the orders, select the orders to be submitted and click Submit. 
 

Figure 34 - Order Import - Submit orders example 
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If the orders are successfully submitted, the Status will change to Submitted. The submitted orders will 

appear in the My Orders view with a Status of ‘New’. 

 

 

 

4.2.3 My Orders 
 

The My Orders view lists the traders buy orders and sell orders. The list of orders is displayed in a view 

with each order represented by a single row. Final orders that have a Status of ‘Matched’ or ‘Cancelled’ 

are displayed as gray text. 
 

Click on the In Progress tab to view all your orders that are not Final, e.g. with a Status of ‘Open’ or 

‘Partially Filled’, as well as Trigger and Unplaced orders. Click on the Completed tab to see your Final 

orders, i.e. Matched or Cancelled orders. 
 

Figure 35 - My Orders view example 
 

 
 
 
 
 
 
 
 
 
 
 
 

The following columns are available in the My Orders view: 
 

TIME The time the order was placed 
 

ORDER ID The unique identifier of the order including date and time and order 

number 
 

ID# The order number 
 

SIDE Indicates if the order is on the Bid or Offer side of the order 
 

STATUS This column will indicate the current status of the order. 

One of the following will be displayed: 

‘Expired’ - An order which has reached its expiry time or date and has now 

been withdrawn from the Order Book 

‘Open’ - An order which has not yet been fully filled. The unmatched 

quantity is still available for matching 

‘Matched’ - An order which has been fully matched and a trade generated 

‘Unplaced’ - An order which is open, but not currently displayed in the 

Order Book. This is an order which has not passed order validation. The 

order will remain with the status ‘Unplaced’ until it is either withdrawn, 

amended or, on the next trading day, it passes validation and is entered 

into the Order Book. 

‘Withdrawn’ or ‘Cancelled’ - An order which has been withdrawn from the 

system. This order is no longer available for matching. 

‘Embargoed’ - An order which has been embargoed for a pre-determined 

period of time. 
 

SECURITY Unique identifying code for the Security 
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BOARD The unique identifier of the Board where the Security is listed 
 

PRICE The bid or offer price for the Security, i.e. the price that the order was 

entered at. 
 

QUANTITY The order quantity entered 
 

BALANCE The quantity of this order that is open for further matching. In case an 

order is no longer active, then the balance will be zero. 
 

MATCHED QTY The quantity of the order that has so far been matched with opposing 

orders 
 

MATCHED VALUE The value of the order that has so far been matched with opposing orders 

ACCOUNT The Trading Account ID of the Firm that the order is placed for  

REFERENCE Reference text entered with the order 

TYPE The type of order, e.g. Limit or Market 
 

FILL TYPE The type of order fill, e.g. None, WON (Whole or None), FOK (Fill Or Kill), 

FAK (Fill And Kill) 
 

DURATION The lifetime (duration) of the order in the system: 

‘Day’ – The order is withdrawn at the end of the day 

‘Good Till Cancel’ – The order is good until it is cancelled 

‘Good Till Date’ – The order is good until the date specified in the Expiry 

Date column 

‘Good Till Time’ – The order is good until the time specified in the Expiry 

Time column 

‘Immediate’ – The order will be withdrawn if it does not immediately 

match. 

Session – The order will be withdrawn if it is not matched in the session in 

which it is entered 
 

TRIGGER If a tick appears in this column, the order is a Trigger order 
 

TRIGGER PRICE This is the price that triggers the order activation for stop orders 
 

TRIGGER DIRECTION Specifies the direction of price movement for the trigger order to be 

activated (Up or Down) 
 

TRIGGER PRICE TYPE Specifies the type of price movement for the trigger order to be activated, 

e.g. ‘B’ (Bid), ‘O’ (Offer) or ‘ L’ (Last traded price) 
 

EXPIRY DATE In the case of a ‘Good Till Date’ order specifies the date at which the 

order will expire 
 

EXPIRE TIME In the case of a ‘Good Till Time’ order, specifies the time at which the 

order will expire 
 

TRADER The User who placed the order 
 

LAST AMENDED BY The User who last amended the order. 
 

Open orders can be withdrawn by selecting the order and clicking Withdraw. Confirm the withdrawal by 

clicking the Ok button. 
 

 

A selected open order can be amended by clicking Details. The Order Details view will be displayed. 
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Figure 36 - Order Details example 

 

 

 
 

 

To amend an order, alter the details and click Amend.  
To amend the quantity, only Balance field could be modified. 
Orders can also be withdrawn by clicking Withdraw. 
Click on History to open the Order History view for the selected order. 

 
4.2.4 Order History 

 

The Order History view lists the order histories of all modifications and status changes applied to an 

order since it was created. To open the Order History view for the selected order, click on History in the 

My Orders table. Click Details to see the Order History Details view. 
 

Figure 37 - Order History view 
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Figure 38 - Order History Details view 
 

 
 

4.2.5 My Trades 
 

The My Trades view lists all the trader’s trades performed in the Trading System for the day. 
 

Figure 39 - My Trades view example 
 
 
 
 
 
 

 
The following columns are available in the My Trades view: 

 

TIME The time this trade was generated 
 

TRADE NO System generated number assigned to the trade 
 

ORDER ID The order number 
 

SECURITY Unique code of security 
 

BOARD The unique code identifier for the Board that the security was traded on 
 

ACCOUNT The Trading Account 
 

REFERENCE Free form reference text 
 

SIDE The side of the order – Buy or Sell 
 

PRICE Traded or matched price 
 

QUANTITY Traded or matched quantity 

MATCHED VALUE Traded or matched value of the trade 

STATUS The status of the trade, e.g. Matched 

USER The Trader who owns the order 
 

Select a side of the trade, e.g. the Sell or Buy side, and click on Details to see the details of one side of 

the trade. 
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Figure 40 – Trade Details view – Buy side example 
 

 
 

 

4.2.6 Trades & Orders Reports 
 

The Trades & Orders Reports view is used to download details about orders and/or trades entered into 

the Nasdaq ME system during a specified date range. The data is saved to a CSV (Comma Separated 

Values) file in the default Download folder of the web browser with the filename format of 

<FIRM_ID>_orders_<date>-<time>.csv or <FIRM_ID>_trades_<date>-<time>.csv. The filename format 

for date ranges includes <from date>-<to date> instead of <date>. 
 

Figure 41 - Trades & Orders Reports view example  
 

 
 
 
 

To download orders to a .csv file, select the From Date and the To Date from the popup Calendar, click 

on the corresponding filename, e.g. FIRM01_orders_<date>-<time>.csv, and click the Download button. 

The .csv file is generated and is available to open in the Downloads section at the bottom of the Trades 

& Orders Reports view. 
 

To download trades to a .csv file, select the From Date and the To Date from the popup Calendar, click 

on the corresponding filename, e.g. FIRM01_trades_<date>-<time>.csv, and click the Download button. 

 

The .csv file is generated and is available to open in the Downloads section at the bottom of the Trades 

& Orders Reports view. 
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4.2.7 Results 
 

The Results view records all attempted and successful transactions that are performed for the trader’s 

current logged in session. 
 

Figure 42 - Results view example 
 

 
 

The following columns are available in the Results view: 
 

TIME The date and time the event took place 
 

TRANSACTION Describes the action that took place 
 

SUCCESS The result of the transaction. If the transaction was successfully applied, a tick 

appears in this column. 
 

ERROR MESSAGE If the transaction was not successful, an error message will be displayed in this 

column.
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5 Mapping of Common Terms 
 

Different terminology is used in Nasdaq Packaged CCP and Nasdaq Matching Engine. The following table 

lists the terms used in each platform. 
 

Figure 43 - Terminology mapping 
 

Nasdaq Packaged CCP (Nasdaq PCCP) Nasdaq Matching Engine (Nasdaq ME) 

 

Amount Value 

 

Asset Class Asset Class (also known as Security Class, SecClass) 

 

Company Name Participant Name 

 

Contracts Quantity (Order Quantity, Trade Quantity) 

 

Country Domicile or Country 

 

Currency Currency, Face Currency 

 

Deal Trade (also known as Matched trade) 

 

Instrument Definition Instrument (also known as Instrument Code, Instr Code, Product) 

 

Instrument Series Security (also known as SecCode, SecBoard, Order Book) 

 

Market Board 
 

Market Place Board Group (also known as Exchange) 

 

Price Price (Order Price, Trade Price) 

 

Stakeholder Participant (also known as Firm, Market Participant, Broker) 

 

Trade Not applicable 
 

Trading Account Trading Account (sometimes called just 'Account') 

 

Not applicable Order 

 

Not applicable Operational Limits 

 

Not applicable Firm Position / Green Holdings 

 

Not applicable Session, Trading Session. 


